Epson Stylus® Photo 1280

Printer Basics
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be misused by improper copying or printing of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

Epson, Epson Stylus, Epson Photo Stickers, and MicroWeave are registered trademarks and Exceed Your Vision is a trademark of Seiko Epson Corporation.

Epson PhotoCenter, Epson Connection, SoundAdvice, and Epson Store are service marks; Epson Print Lab and PhotoEnhance are trademarks; and ColorLife, BorderFree, Resolution Performance Management, and RPM are registered trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
## Contents

**WELCOME!** 7  
About Your Software 7  
About Your Documentation 8  
  Viewing the On-Screen Reference Guide 9

**LOADING PAPER** 11  
Loading Paper in the Sheet Feeder 11  
Loading Envelopes 13  
Loading Roll Paper 14  
  If the Roll Paper Jams or Feeds Incorrectly 17  
  Removing and Storing Roll Paper 17

**PRINTING FROM START TO FINISH** 19  
Basic Printing in Windows 20  
  Selecting the Settings You Use Most Often 22  
Basic Printing With Macintosh OS X 23  
Customizing Your Print Settings 27  
  Customizing Windows Print Settings 27  
  Customizing Macintosh Print Settings 31  
Selecting the Correct Media Type 33  
Printing Borderless Photos 34  
  Windows 34  
  Macintosh OS X 35
### MAINTAINING YOUR PRINTER

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning the Print Head</td>
<td>37</td>
</tr>
<tr>
<td>Running the Head Cleaning Utility</td>
<td>38</td>
</tr>
<tr>
<td>Examining the Nozzle Check Pattern</td>
<td>39</td>
</tr>
<tr>
<td>Replacing an Ink Cartridge</td>
<td>39</td>
</tr>
<tr>
<td>Removing and Installing Ink Cartridges</td>
<td>40</td>
</tr>
<tr>
<td>Aligning the Print Head</td>
<td>43</td>
</tr>
<tr>
<td>Cleaning the Printer</td>
<td>45</td>
</tr>
<tr>
<td>Transporting the Printer</td>
<td>46</td>
</tr>
</tbody>
</table>

### PROBLEM SOLVING

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Parts</td>
<td>48</td>
</tr>
<tr>
<td>Diagnosing Printer Problems</td>
<td>49</td>
</tr>
<tr>
<td>Checking the Control Panel Lights</td>
<td>49</td>
</tr>
<tr>
<td>Running a Printer Check</td>
<td>51</td>
</tr>
<tr>
<td>Problems and Solutions</td>
<td>52</td>
</tr>
<tr>
<td>Problems Setting Up the Printer or Installing Software</td>
<td>52</td>
</tr>
<tr>
<td>Printing Problems</td>
<td>53</td>
</tr>
<tr>
<td>Print Quality Problems</td>
<td>54</td>
</tr>
<tr>
<td>Problems with Paper Feeding</td>
<td>56</td>
</tr>
<tr>
<td>Solving Miscellaneous Printout Problems</td>
<td>58</td>
</tr>
<tr>
<td>Uninstalling and Reinstalling the Windows Printer Software</td>
<td>59</td>
</tr>
<tr>
<td>Where To Get Help</td>
<td>60</td>
</tr>
<tr>
<td>Software Technical Support</td>
<td>61</td>
</tr>
</tbody>
</table>
Welcome!

Your Epson Stylus® Photo 1280 printer delivers state-of-the-art print quality for both professional and home office users. With resolutions up to $5760 \times 720$ dpi, it’s the ideal output device for everything from exhibition prints to family photos. You can print edge-to-edge, borderless prints on a variety of roll paper sizes, or on single sheets of special Epson® photo papers available in popular print sizes.

About Your Software

The printer software CD-ROM that came with your printer includes all the software you need for printing. See the Start Here sheet for installation instructions.

- **Your printer driver** runs your printer and lets you control how your documents look. You can’t use your printer without it.

  **Note:** It’s a good idea to check Epson’s support web site periodically for possible updates to your printer driver. Visit http://support.epson.com and check the section for your product to see if there is a new driver available, free of charge, for downloading to your computer. Download instructions are included for your convenience.

The Windows driver includes the Epson ICC Color Profiles, which work with Adobe® Photoshop®, Photoshop Elements, and other software applications to give you control of the colors in your prints when used in a color-managed workflow.

- **Epson PhotoCenter** is Epson’s free photo-sharing web site where you can store, organize, and share your photos; print high-resolution photos straight from the web; and order prints and custom photo gifts. The printer software installer lets you add a link to the Epson PhotoCenter on your desktop.
Your printer software CD also includes GretagMacbeth® Eye-One™ Share, a complete color workshop on your desktop. Try the tutorial to see what this software can do. For instructions and more information, click the Help button when you’re using the program.

Adobe Photoshop Elements 3.0 (on a separate CD-ROM) provides powerful photo-editing tools plus intuitive organizing and sharing capabilities—from the maker of Photoshop, the leading image-editing software worldwide. See the on-screen Getting Started Guide for instructions.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet. Then read this book for instructions on:

■ Loading paper
■ Printing with Windows® or on a Macintosh®
■ Maintaining the printer
■ Solving basic problems

Please follow these guidelines throughout:

**Warning:** Warnings must be followed carefully to avoid bodily injury.

**Caution:** Cautions must be observed to avoid damage to your equipment.

**Note:** Notes contain important information about your printer.

**Tip:** Tips contain additional hints for better printing.

For details about your printer, and for network setup instructions and technical specifications, see your on-screen Reference Guide, as described below.
Viewing the On-Screen Reference Guide

You should have installed the on-screen Reference Guide for your printer when you set up your printer, as described on the Start Here sheet. (If not, insert the printer software CD-ROM and select Install Reference Guide from the Install Menu to copy the manual to your computer.)

Note: You need a browser to view the Reference Guide—such as Microsoft® Internet Explorer 4.0 or later, Netscape® Navigator® 3.0 or later, Mozilla™ Firefox™ 1.0 or later, or Safari™ 1.0 or later. If you are using a different browser, the pages may not display correctly. (A browser is not included on the printer software CD-ROM.)

To view the guide, double-click the Reference Guide icon on your desktop. You see this screen:

Click a topic on the left to expand the table of contents. After expanding the table of contents, you can click on the topic you want to view.
If there’s a right arrow ➡️, click it to view subtopics, then click on a topic to go to it. Click the down arrow ☹️ to close a subtopic list.

**Note:** If you see an icon for a graphic when viewing your *Reference Guide* in Netscape Navigator, click the **Reload** button to load the graphic.
Loading Paper

This chapter explains how to load paper in your printer, as described in these sections:
- “Loading Paper in the Sheet Feeder” below
- “Loading Envelopes” on page 13
- “Loading Roll Paper” on page 14

For instructions on loading special media, see your on-screen Reference Guide.

Loading Paper in the Sheet Feeder

Follow these guidelines when loading paper:
- Load the printable side face up. It’s usually glossy, whiter, or brighter than the other side.
- Always load the short edge first, even when printing landscape-oriented documents.
- Load letterhead or preprinted paper into the printer top edge first.
- You can load up to 20 sheets of Epson Photo Paper, Glossy Photo Paper, or Matte Paper Heavyweight.
- Load Epson Premium Glossy, Semigloss, and Luster Photo Paper one sheet at a time.
- Don’t load paper above the arrow on the left edge guide.
1. Make sure your printer and computer are turned on.

2. Place your paper against the right edge of the sheet feeder and slide the left edge guide against the paper. (Don’t push the paper down into the feeder.)

3. Pull out the output tray extensions.
Loading Envelopes

You can load up to 10 envelopes at a time.

**Tip:** For best results, press each envelope flat before loading it, or load one envelope at a time.

1. Open the printer cover and move the thickness lever to the + position.

Remember to move the thickness lever back to the 0 position when you’re done printing envelopes.

2. Insert the envelopes flap edge first, printable side up, against the right edge of the sheet feeder.

3. Slide the left edge guide against the envelopes.

4. Before you print, select **Plain paper** as the Media Type setting and choose the correct envelope size for the Paper Size setting, as described on page 20 (Windows) or page 23 (Macintosh OS X).
Loading Roll Paper

These steps show how to load 4-inch wide roll paper, but you can follow the same procedure to load wider roll paper.

1. Before you begin, turn on your printer and remove any paper loaded in the sheet feeder.

2. Remove the paper support and lower the output tray.

3. Insert the paper support adapter into the positioning slots on the back of the printer, as shown.

4. Set the roll paper onto the roll paper holders. Avoid touching the printable side of the roll paper as much as possible. If necessary, remove the tape and protective paper from the end of the roll.

5. Make sure the edge is cut straight across, with 90° corners. If the end is cut diagonally, you may have problems feeding the paper.
6. If the paper coming off the roll is curled too tightly, you can uncurl it. Locate the uncurling sheet that came in your printer box. Insert the end of the roll paper inside the uncurling sheet and roll it in the direction opposite to the paper’s curl. (This step is especially important with roll paper that is wider than 4 inches.)

7. Insert the tabs on the roll paper holders into the slots on the paper support adapter. As you face the front of the printer, insert the tab on the right roll paper holder into the slot at the right end of the adapter, and the tab on the left roll paper holder into the appropriate slot to the left.

**Note:** It’s important to insert the tab on the right roll paper holder into the slot at the right end of the adapter. Otherwise your roll paper won’t load correctly, and you may see an error.
8. Feed the end of the paper into the printer as far as it will go, then slide the left edge guide against the paper.

9. Gently rotate the roll backward to remove any slack from the paper.

10. Make sure the output tray is open but the extensions are closed, and leave ample room at the front of the printer for your paper to eject smoothly.

11. Gently hold the paper in place as you press and release the roll paper button to feed the paper into the printer.

**Note:** Don’t force the paper to feed into the printer. Allow the paper to move automatically.

Make sure you press the roll paper button when you feed roll paper. Pressing the maintenance button by mistake may cause paper feeding problems.
If the Roll Paper Jams or Feeds Incorrectly

If the roll paper feeds incorrectly, do the following:

1. Press the ☛ roll paper button for three seconds to rewind the paper. (You may have to do this more than once to rewind the paper completely.)

   If the paper is jammed and won’t rewind, turn the printer off. Then cut the roll at a point a few inches away from where it exits the printer. Make your cut as straight as possible to avoid further feeding problems. Gently pull the roll backward to rewind it, and then turn the printer on again.

2. After you rewind the paper, the ☛ maintenance light comes on. Press the ☛ maintenance button to turn the light off.

3. Reload the paper, making sure the end is straight and not damaged. If necessary, trim the end again before reloading.

Removing and Storing Roll Paper

When you finish a print job on roll paper, you can position the paper for another print job or remove it from the printer. Follow these steps:

1. Press the ☛ roll paper button. The printer prints a small line on the roll paper to show you where to cut it and feeds the paper forward.

2. If you want to continue printing on roll paper, press the ☛ roll paper button again; the paper feeds back into the printer. Then send the next print job; the paper will move into the correct loading position before printing.

   If you’re finished printing on roll paper, follow the rest of the steps to remove it.

3. Cut the roll paper on the side of the line facing away from the printer. Make your cut as straight as possible to avoid feeding problems.
**Note:** Don’t pull on the paper as you cut it; you may damage your printout.

It’s a good idea to use a ruler or straight edge to make sure the end of the roll paper is cut at right angles. A diagonal cut may cause paper feeding problems.

4. Hold down the 🔄 roll paper button for about three seconds. The roll paper feeds backward, so you can remove it from the sheet feeder. (You may need to repeat this step to back it all the way out.)

5. Remove the roll paper from the holder and return the unused roll to its original package.

Store your printout in a resealable plastic bag. Keep both printed and unused roll paper away from high temperatures and humidity and out of direct sunlight.

**Note:** After you rewind the roll paper, the 🔵 maintenance light remains on. You must press the 🔵 maintenance button to turn the light off before you can resume printing.
This chapter covers the following:

- “Basic Printing in Windows” on page 20
- “Basic Printing With Macintosh OS X” on page 23
- “Customizing Your Print Settings” on page 27
- “Selecting the Correct Media Type” on page 33
- “Printing Borderless Photos” on page 34

Tip: Whenever you print, make sure you:

- **Use the right paper.**
  For the best-looking photos, most vivid colors, and greatest detail, always use genuine Epson papers.

- **Choose the right printer settings for the paper.**
  Your printer automatically adjusts itself for the type of paper you’ve selected, so make sure your printer settings are correct for the paper you loaded.
Basic Printing in Windows

When you’re ready to print a document from your Windows application, follow these steps:

1. Make sure the printer is on and paper is loaded.
2. From the File menu, click Print. You see a Print window like this one:

   ![Print window]

   **Note:** If you click the print icon on your application’s tool bar instead of selecting Print from the File menu, you may not see this window and will not be able to change the printer software settings before printing.

3. Make sure EPSON Stylus Photo 1280 is selected.
4. Click Properties or Preferences. (If you see a Setup, Printer, or Options button, click it first. Then click Properties or Preferences on the next screen.)
You see your printer settings window:

5. Make the following settings:

- Set the Mode to Automatic. It's the easiest way to get good printing results on all types of paper.

- Choose the Media Type for your paper. If you're not sure which setting to select, see page 33.

- For Ink, select Color to print a color document or black and white photograph. Choose Black to print a grayscale or black text document.

  **Note:** The Automatic setting for Mode gives you the best combination of quality and speed for most prints. For the highest print quality (Photo RPM®) on selected papers, click Custom, then click the Advanced button that appears. See “Customizing Windows Print Settings” on page 27 for instructions on selecting Photo RPM.

6. Click OK to save your settings, return to the Print window, and print.

  **Note:** For more information about printer settings, click the Help button. You can also right-click any item on the screen and then click What’s This?
After a moment, this window appears and shows the progress of your print job. You can use the buttons to cancel, pause, or restart printing. You can also see how much ink you have left.

**Selecting the Settings You Use Most Often**

When you change printer settings from within an application, the settings apply only for what you print during the current session. If you want the settings to be in effect whenever you use that program, and for other programs as well, you can change the Windows default printer settings.

Follow these steps:

1. **Windows XP:** Click Start > Printers and Faxes (or Start > Settings > Printers and Faxes).

   **Windows 2000:** Click Start > Settings > Printers.

2. Right-click the **EPSON Stylus Photo 1280** printer and select Printing Preferences.

3. Select the default settings you want to use for all your applications. Then click OK when you’re finished and close the Printers window.

If you want different settings for a particular document, you can always change the settings in your application program. The changed settings will remain in effect until you close the program.
Basic Printing With Macintosh OS X

When you’re ready to print a document from your Macintosh OS X application, follow these steps:

   Note: Make sure you added your printer to the Printer Setup Utility or Print Center as described on the Start Here sheet.

1. Make sure the printer is on and paper is loaded.
2. From the File menu, select Page Setup.
3. Select your printer in the Format for menu.

   ![Page Setup Window]

   Note: If you’re printing on roll paper, select one of the roll paper options. If you want to print without margins, select one of the borderless versions. (See page 35 for details.)

4. Select the Paper Size and Orientation. When you’re finished, click OK.
5. Select Print from the File menu. You see a screen like this:

![Print Screen](image)

- Select the same setting you chose in the Page Setup window.
- Click here and select Print Settings.

6. Open the Printer menu and select the same printer option you chose in the Page Setup menu.

**Note:** Always select the same printer option in the Format for menu and the Printer menu. If the settings are different, you may get unexpected results.

7. Select **Print Settings** from the pull-down menu.

You see your basic print settings:

![Print Settings Screen](image)

- Select your paper type (see page 33).
- Select Color for color documents and for black and white photographs.
- Select Automatic mode.
8. Make the following settings:

- Set the mode to **Automatic**. It’s the easiest way to get good printing results on all types of paper.
- Choose the Media Type for your paper. If you’re not sure which setting to select, see page 33.
- For Ink, select **Color** to print color documents and black and white photographs, or **Black** to print grayscale or black text documents.

**Note:** The **Automatic** setting for Mode gives you the best combination of quality and speed for most prints. For the highest print quality (Photo RPM) on selected papers, click **Advanced Settings**. See “Customizing Macintosh Print Settings” on page 31 for instructions on selecting Photo RPM.

9. You can also select additional options such as the following in the pull-down menu:

- **Copies & Pages**, to select the number of copies or a page range
- **Layout**, to select page layout options
- **Output Options**, to save your print job as a PDF file
- **Color Management**, to select ColorSync® adjust the color controls, change the gamma setting, or turn off color adjustments by the printer software
- **Summary**, to view a list of all your selections

10. Optionally, click **Preview** to preview your print job.

11. Click Print.
To monitor the progress of your print job, click the Print Setup Utility (or Print Center) icon when it appears in the dock on the bottom of your desktop. Then double-click Stylus Photo 1280 in the printer list. You see a screen like this:

You can use the Printer Setup Utility or Print Center to do any of the following:

- Click the print job, then click Delete to delete the job.
- Click the print job, then click Hold to pause printing.
- Click a print job marked “Hold” and click Resume to resume printing.
- If multiple print jobs are listed, click a print job, then click the Priority arrow as necessary to reorder the jobs.
Customizing Your Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or selecting a variety of special effects and layouts.

Customizing Windows Print Settings

1. On the Main tab, click Custom.

2. Open the Custom Settings list and select one of these settings:
   - **Economy**: For printing rough drafts of text on plain paper.
   - **ICM (Image Color Matching)**: For matching colors as closely as possible with ICM-compatible monitors or scanners.
   - **sRGB (standard Red Green Blue)**: For color matching with other sRGB devices, or for images designed for the Web. See your Windows help for details.
3. Click the **Advanced** button. You see the Advanced window.

**Note:** You must click the **Custom** button on the Main tab to see the **Advanced** button.

4. For the highest quality printing (highest resolution), select **Photo RPM** (if available for your Media Type). Then click **OK**.

**Note:** Printing is slower at higher resolutions. For more information about advanced settings, click the **Help** button.

5. If you’re using a color management system, such as the Epson ICC color profiles that came with your printer, and don’t want your printer to control the colors, select **No Color Adjustment**.

6. Set any other advanced settings you want to use.

7. If you want to save your custom settings as a group, click **Save Settings**. Then enter a name for your settings in the Custom Settings window and click **Save**.
Note: When you want to use them again, you can select this group of settings in the Custom Settings list on the Main menu. You must click Custom to see the Custom Settings list.

8. Click the Paper tab to change paper size, page orientation, or the paper source. If you’re printing on roll paper, change the Paper Source to Roll Paper.

Tip: If your program’s Print window includes options for setting the number of copies, orientation, or paper source, check these before you print to make sure they’re correct.
9. Click the **Layout** tab to change layout settings:

10. If you want to preview your job before printing, click the **Main** tab and click the **Print Preview** checkbox.

11. Click **OK** to save your settings and return to the Print window, then click **OK** (or Print) to print.
**Customizing Macintosh Print Settings**

1. On the printer settings window, click **Custom**, then click the **Custom Settings** list to open it.

2. Optionally, select one of these settings from the Custom Settings list:
   - **Economy**: For printing rough drafts of text on plain paper.
   - **ColorSync**: For matching printed colors as closely as possible with ColorSync compatible devices.
3. For more options, click Advanced Settings. You see this window:

![Advanced Settings Window]

To select color management settings, select Color Management from the Print Settings pull-down menu.

Click here to select Photo RPM (5760 x 1440 dpi) for the best print quality on certain types of paper.

Select other print options here.

**Note:** For more information on advanced settings, click Help.

4. If you’re using a color management system and don’t want your printer to control colors, select Color Management from the Print Settings pull-down menu, and select No Color Adjustment.

5. For the highest print quality, select Photo RPM (if available for your Media Type).

6. Set any other advanced settings you want to use.

7. Click Print.
Selecting the Correct Media Type

Select the correct Media Type setting so your printer knows what kind of paper you're using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-On Transfer Paper</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson All-Purpose Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson ColorLife® Photo Paper</td>
<td>ColorLife Photo Paper</td>
</tr>
<tr>
<td>Epson Semigloss Scrapbook Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Stickers®</td>
<td>Photo Quality Glossy Film</td>
</tr>
<tr>
<td>Epson Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
</tbody>
</table>
Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the edges of the page. Although BorderFree® printing is a bit slower, you get beautiful snapshots or enlargements without trimming.

Windows

Follow these steps to print borderless photos on single sheets:

1. Start your photo application and open your photo file.
2. Click File > Print. Then click Properties or Preferences.
3. Make sure the mode is set to Automatic.
4. Select your paper type as the Media Type option.
   
   Note: See the inside back cover for a list of BorderFree papers.

5. Click the Paper tab. You see the following:

   ![EPSON Stylus Photo 1280 Properties window]

   - Select Sheet Feeder and click the Borderless checkbox
   - Select the paper size
   - Select the orientation

6. Choose Sheet Feeder or Roll Paper as your Paper Source.
7. Click the **Borderless** checkbox. Read the message and click **OK**.


   **Note:** If you want borderless prints on 4 × 6 inch Glossy Photo Paper, choose Photo Paper 4 × 6 in **No Perforations**.

   You can also print borderless photos on letter-size paper.

9. Select the Orientation setting, then click **OK**.

10. Click **OK** or **Print**.

**Macintosh OS X**

Follow these steps to print borderless photos on single sheets:

1. Start your photo application and open your photo file.

2. Click **File > Page Setup**. You see the Page Attributes dialog box.

3. In the Format for pull-down menu, select **Stylus Photo 1280 (Sheet Feeder - Borderless)**.

   **Note:** If you don’t see this option, make sure you added the printer to the Printer Setup Utility or Print Center correctly. See the *Start Here* sheet for instructions.

4. Choose the Paper Size and Orientation, then click **OK**.
**Note:** If you are printing on 4 × 6 inch Glossy Photo Paper, BorderFree, choose Photo Paper 4 × 6 in No Perforations.

You can also print borderless photos on letter-size paper.

5. Click File > Print.

6. Select **Print Settings** from the pull-down list.

7. In the Printer pull-down menu, select **Stylus Photo 1280 (Sheet Feeder - Borderless)**.

8. Make sure the Mode is set to **Automatic**.

9. Select your paper as the Media Type option.

   **Note:** See the inside back cover for a list of BorderFree papers.

10. Make any other print settings you want. Then click **Print**.

**36** Printing from Start to Finish
Cleaning the Print Head

If your printed image is unexpectedly light, or dots are missing from the image, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Cleaning the print head uses ink, so clean it only if print quality declines.

This section explains how to clean the print head using the printer’s Head Cleaning utility, which is the recommended method when the printer is connected directly to your computer (not over a network).

You can also clean the print head by holding down the \( \textbullet \) maintenance button on the control panel for three seconds (when the \( \textbullet \) maintenance light is off).

**Caution:** When you don’t turn on your printer for a long time, the print quality can decline. It’s a good idea to turn on your printer at least once a month to maintain good print quality.
Running the Head Cleaning Utility

1. Make sure the printer is on but not printing, and the maintenance light is off.

   Note: You can’t clean the print head if the maintenance light is flashing or on. Replace the appropriate ink cartridge instead.

2. Windows: Open an application and select Print from the File menu. Click Properties or Preferences. Then click the Utility tab.

   Macintosh OS X: Open the Applications folder on your hard drive. Double-click EPSON Printer Utility and select SP 1280 in the printer list. Then click OK.

3. On the Utility menu, click the Head Cleaning button.

4. Follow the instructions on the screen to clean the print head.

   Cleaning takes about 30 seconds, during which the printer makes some noise and the power light flashes.

   Caution: Never turn off the printer while the power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.

5. When the power light stops flashing, run a nozzle check to confirm that the print head nozzles are clean.

   Make sure paper is loaded in the printer and click Print Nozzle Check Pattern (Windows) or Confirmation (Macintosh). Then click Print. The nozzle check pattern prints (see the next section for details).

6. If the nozzle check pattern has no gaps in its lines, click Finish.

   If the pattern has white lines, click Clean to clean the print head again.

   If you don’t see any improvement after cleaning three or four times, check the solutions in “Print Quality Problems” on page 54. You can also turn the printer off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.
**Examining the Nozzle Check Pattern**

Examine the nozzle check pattern you print. It should look something like this:

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Each staggered horizontal and straight vertical line should be complete, with no gaps in the dot pattern. If your printout looks okay, you’re done.

If there are gaps in the lines, clean the print head again; see page 37 for instructions.

---

**Replacing an Ink Cartridge**

When the ⚠️ maintenance and ⚡️ power lights are both flashing, one of your ink cartridges is low on ink. This is a good time to make sure you have a new cartridge.

When the ⚠️ maintenance and ⚡️ power lights both stay on, an ink cartridge is empty and you need to replace it.

**Caution:** You cannot print if either ink cartridge is empty. Leave the empty cartridge installed in the printer until you have obtained a replacement; otherwise the ink remaining in the print head nozzles may dry out.

When an installed ink cartridge is more than six months old, you may also need to replace it if you notice that your printouts don’t look as good as they used to. If print quality doesn’t improve after cleaning and aligning the print head, you can replace the cartridge even if the ⚠️ maintenance and ⚡️ power lights aren’t flashing.
Use these Epson ink cartridges within six months of installing them and before the expiration date on the package:

- Black: T007201
- Color: T009201

**Caution:** To ensure good results, use genuine Epson ink cartridges and do not refill them. Other products may cause damage to your printer not covered by Epson’s warranty.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller referral.

**Removing and Installing Ink Cartridges**

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge replacement procedure, you must complete all the steps in one session.

Follow these steps to replace ink cartridges:

1. Make sure the printer is turned on and not printing.

2. Open the printer cover and press the ink cartridge replacement button. The print head moves left to the ink cartridge replacement position.

   **Caution:** To avoid damaging the printer, never move the print head by hand.
3. Use the printer software to check the ink levels and see which cartridge you need to replace:

**Windows:** From an application, open the printer software and check the ink levels on the Main tab. (See page 20 for instructions on opening the software.) You can also check the ink levels by pressing **Start > Settings > Printers and Faxes** (or **Start > Control Panel > Printers and Faxes**). Right-click the Stylus Photo 1280 and select **Printing Preferences**.

**Macintosh OS X:** Choose **Applications > EPSON Printer Utility > SP 1280**. Click **OK**, then click **EPSON StatusMonitor**.

4. The color cartridge is on the right and the black cartridge is on the left. Pull up the ink cartridge clamp. The cartridge rises from its holder.

5. Lift the cartridge out of the printer and dispose of it carefully.

**Warning:** Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water.

6. Unwrap the new ink cartridge. Then remove only the yellow tape seal on top.

**Caution:** You must remove the yellow seal from the top of the cartridge or you will permanently damage the cartridge.

Don’t touch the green circuit board on the back of the cartridge; you may inhibit normal operation and printing.
7. Tilt the new cartridge toward you slightly as you insert it. Lower the cartridge so that the tabs rest on the hooks.

**Caution:** Don’t place the cartridge tabs *under* the hooks on the holder clamp; you may damage the clamp when you close it.

8. Press down firmly on the ink cartridge clamp until it snaps into place.

9. If you need to replace the other ink cartridge, repeat steps 4 through 8 before continuing with step 10.

10. Press the ink cartridge replacement button and close the printer cover. The printer moves the print head and begins charging the ink delivery system.

   The $\bigcirc$ power light flashes, and the printer makes noise. Charging takes about one minute. When it’s finished, the $\bigcirc$ power light stops flashing and stays on.

   **Caution:** Never turn off the printer while the $\bigcirc$ power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.
Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print head. Your printer must be connected to a local port, not on a network, to use the Print Head Alignment utility. Follow these steps:

1. Make sure the printer is on but not printing, and letter-size paper is loaded.

   **Tip:** For best results, load Epson ink jet paper in the printer whenever you check the print head alignment.

2. **Windows:** Open an application and select Print from the File menu. Click Properties or Preferences. Then click the Utility tab.

   **Macintosh OS X:** Open the Applications folder on your hard drive. Double-click EPSON Printer Utility and select SP 1280 in the printer list. Then click OK.

3. You see the Utility menu. Click the Print Head Alignment button.

4. Follow the instructions on the screen to print an alignment page for black printing. You see this window on your screen:
5. On the test page, select the pattern with the two vertical lines most precisely printed on top of each other. You may need to use a magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. Enter the number of the best pattern for each row in the corresponding boxes on the screen. Then click Next.

If you can’t find an aligned pattern, enter the number of the best pattern and click Realignment to print another test page. Then repeat this step.

6. Follow the instructions on the next two screens to print an alignment pattern for color printing.

7. On the test page, select the pattern that is the least grainy. Select one pattern for each of the two rows and enter its number in the corresponding boxes on the screen. Then click Finish.

If you can’t find a smooth pattern, enter the number of the best pattern and click Realignment to print another test page. Then repeat this step.
Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. Follow these steps:

1. Turn off the printer and wait for the power light to go out.
2. Unplug the power cord and disconnect the printer cable.
3. Remove all the paper, then use a soft brush to clean any dust or dirt from the sheet feeder.
4. Clean the exterior of the printer with a soft, damp cloth.
5. Clean ink out of the printer’s interior with a soft, damp cloth.

Caution: Don’t touch the gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can damage the printer components and case.

Don’t get water on the printer components, and don’t spray lubricants or oils inside the printer.

Don’t use any cleaning sheets included with special media; they may jam inside the printer.
Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in its original box or one of a similar size. Follow these steps:

**Caution:** To avoid damage, always leave the ink cartridges installed when transporting the printer.

Be sure to remove the tape used in step 4 after installing the printer in its new location.

1. Turn on the printer, wait until the print head locks in the far right position, then turn the printer off.
2. Unplug the power cord from the electrical outlet. Then disconnect the printer cable from the printer.
3. Remove any paper from the printer and remove the paper support.
4. Open the printer cover. Secure the ink cartridge holder to the printer with tape as shown, then close the printer cover.
5. Push in the output tray extensions and close the tray.
6. Repack the printer and attachments in the original box using the protective materials that came with it. See the *Start Here* sheet for details.

Keep the printer level as you transport it.

After transporting the printer, remove the tape securing the print head and test your printer. If you notice a decline in print quality, clean the print head (see page 37); if output is misaligned, align the print head (see page 43).
Problem Solving

This section gives you the basics for diagnosing and solving printer problems.

■ First see “Diagnosing Printer Problems” on page 49 to help determine the cause of the problem.

■ Then see “Problems and Solutions” on page 52 for solutions to common setup and printing problems.

**Caution:** It’s a good idea to check Epson’s support web site periodically for possible updates to your printer driver. Visit http://support.epson.com and check the section for your printer to see if there is a new driver available, free of charge, for downloading to your computer. Download instructions are posted for your convenience.
Printer Parts

- Sheet feeder
- Left edge guide
- Paper support
- Right edge guide
- Printer cover
- Output tray
- Output tray extensions
- Ink cartridge holders (not removable)
- Paper thickness lever
- Ink cartridge replacement button
- Roll paper button
- Maintenance button
- Control panel
- Maintenance light
- Power light
- Power button
Diagnosing Printer Problems

You can diagnose some problems by checking the printer’s control panel lights, as described in this section, or running a printer check, as described on page 51.

Checking the Control Panel Lights

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ is on</td>
<td>The printer is ready to print.</td>
</tr>
<tr>
<td>☑ flashes</td>
<td>The printer is receiving a print job, charging ink, or cleaning the print head. It also flashes when the print head moves to the ink cartridge replacement position.</td>
</tr>
</tbody>
</table>
| ☑ and ☐☐ flash | When both lights flash, one of the ink cartridges is low on ink. To find out which one, do the following:  
  ▪ **Windows:** Check the ink level graphic on the Main tab in the Printer Settings window in the printer software. See page 20 for instructions on opening the software.  
  ▪ **Macintosh OS X:** Choose Applications > EPSON Printer Utility > SP 1280 > EPSON StatusMonitor.  
  Then replace the ink cartridge as described on page 39. |
<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 and 🔄 is on</td>
<td>When both lights are on, one of the ink cartridges is out of ink. Determine which cartridge is empty. Then replace the cartridge as described on page 39. If both lights come on after you’ve replaced a cartridge, you may have installed a cartridge your printer can’t use.</td>
</tr>
<tr>
<td>🔄 is off and 🔄 is on</td>
<td>Jammed paper may be blocking movement of the print head, or you may have an internal error. Turn off the printer, open the cover, and check for any jammed paper. Also, make sure you removed all the packing material, as described on the <em>Start Here</em> sheet. Then turn the printer back on. If the error isn’t cleared, contact your dealer or Epson. See page 60 for contact information.</td>
</tr>
</tbody>
</table>
| 🔄 flashes and 🔄 is on| Paper is out or loaded incorrectly, or you have a paper jam. If paper is out or loaded incorrectly, load or reload your paper. Then press the 🔄 maintenance button to turn off the 🔄 maintenance light and resume printing. (If you’re printing on roll paper, press the 🔄 maintenance button to turn off the 🔄 maintenance light, then press the ⏸ roll paper button to resume printing.) If paper is jammed, do one of the following:  
  ■ If you’re printing on sheet paper, press the 🔄 maintenance button to try to clear the jam. If that doesn’t work, turn off the printer and gently pull the paper forward (toward the output tray) to pull it out. Then turn the printer on and press the 🔄 maintenance button to resume printing.  
  ■ If you’re printing on roll paper, press the ⏸ roll paper button for at least three seconds to clear the jam. If that doesn’t work, see page 17 for details about clearing roll paper jams. |
| 🔄 and 🔄 are off       | When both lights are off, the printer is not receiving power. Try these solutions:  
  ■ Make sure the printer is turned on.  
  ■ Turn off the printer, plug in the power cord securely, and turn the printer on again.  
  ■ Make sure the outlet is working and is not controlled by a switch or timer. If in doubt, try another outlet. |
Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer itself or some other source. Follow these steps:

1. Make sure both the printer and computer are turned off. Then disconnect the interface cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Hold down the maintenance button, then press and release the power button. Continue holding down the maintenance button until the power light starts to flash, then release it.

   The printer prints one page showing its ROM version number, ink counter, and a nozzle check pattern. Only the nozzle check pattern is shown below. (If the pattern has gaps in its dots, you need to clean the print head; see page 37.)

   ![Nozzle Check Pattern]

4. To end the check, turn the printer off after it prints the check page. Then reconnect the interface cable and turn on your printer and computer.

   If the check page prints, the problem probably lies in your software settings, the interface cable, or your computer. Another possibility is that your printer or application software may not be installed correctly.

   If the check page doesn’t print, you may have a problem with your printer. Try the suggestions in “Problems and Solutions” beginning on page 52. If nothing seems to work, contact your dealer or Epson as described on page 60.
Problems and Solutions

Here are some troubleshooting tips if you have problems setting up your printer, installing software, or printing.

Problems Setting Up the Printer or Installing Software

The printer makes noise after ink cartridge installation.

- The first time you install ink cartridges, the printer must charge its ink delivery system for about two minutes. Wait until charging finishes (the © power light stops flashing) before you turn off the printer or it may charge improperly and use excess ink the next time you turn it on. If the printer stops moving or making noise, but the © power light is still flashing after 5 minutes, turn off the printer. If the light is still flashing when you turn it back on, contact Epson as described on page 60.

- Make sure the ink cartridge clamps are locked down completely and no packing material remains in the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

- Make sure your printer is turned on and the printer cable is securely connected at both ends. Then carefully follow the installation instructions on the Start Here sheet. Also make sure your system meets the requirements beginning on page 63.

- Close your other applications, including any screen savers and virus protection software, and install again.

- For Windows 2000, if you see an error message or your software doesn’t install correctly, you may not have software installation privileges. Contact your System Administrator.

- For Windows 2000, don’t select Block under Control Panel> System> Hardware> Driver Signing; select Ignore or Warn instead.
■ Make sure Windows XP or 2000 was preinstalled on your system. The USB Printer Device Driver may not install correctly if you’ve upgraded your system from an earlier version of Windows.

■ Make sure the Universal Serial Bus Controller is working properly. See your Windows online help system for details. If it’s not working, contact your computer manufacturer.

■ If you’re printing over a network, see your on-screen Reference Guide for instructions on configuring your printer for use on a network.

Printing Problems

The ○ power light is on, but nothing prints.

■ Make sure the interface cable is connected securely and the cable meets the system requirements on page 63 or 63.

■ Run a printer check as described on page 51. If the check page prints, make sure your printer and application software are installed correctly.

■ If you’re printing on a network, you need to set up your printer for network printing, as described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see page 37.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface.

Your printer makes noise when you turn it on or after it has been sitting for awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the requirements listed in “Notices.” If you’re printing a high-resolution image, you need more than the minimum requirements listed.

You may also need to:

■ Clear space on your hard disk or run a defragmentation utility.

■ Close open applications that you’re not using.

■ Increase your system’s memory (RAM).
For the fastest printing, try these tips:

■ Choose **Black** ink if your document doesn’t include color.

■ Set the Quality/Speed slider to **Speed**.

■ Turn **MicroWeave**® off and/or turn **High Speed** on. In Windows, these settings are on the Advanced window. In Macintosh OS X, these settings are on the Print Settings window.

■ If you’re using the parallel port, enable ECP/DMA mode. See your computer documentation or contact the manufacturer for help.

<table>
<thead>
<tr>
<th>Print Quality Problems</th>
</tr>
</thead>
</table>

You see banding (light lines).

■ The print head nozzles may need cleaning; see page 37 for instructions.

■ Make sure the Media Type setting matches the paper you loaded; see page 33 for guidelines.

■ Make sure the printable side of the paper is face up. It’s usually whiter or shinier.

■ The ink cartridges may need replacing. To replace an ink cartridge, see page 39.

■ Try using Automatic mode. See page 21 (Windows) or page 25 (Macintosh OS X) for instructions.

■ Run the Print Head Alignment utility; see page 43 for instructions.

■ Set the paper thickness lever to the **0** position. Set the lever to the **+** position when you print on thicker paper or envelopes. You may also need to turn off **High Speed** in the printer software.
Your printout is blurry or smeared.

- Make sure your paper isn’t damp or curled, or loaded face down (the printable side should be face up). If it’s damp or curled, reload a new stack of paper.
- Use a support sheet with special paper, or try loading your paper one sheet at a time.
- Make sure your paper meets the specifications listed in the on-screen Reference Guide.
- Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
- Run the Print Head Alignment utility. See page 43 for instructions.
- Check the paper thickness lever position. If it’s in the + position, your printer is set for thicker paper or envelopes. (See page 13.) If you’ve loaded other paper, your image may smear. For most papers, set the paper thickness lever to the 0 position.

- Remove each sheet from the output tray after printing, especially when you’re printing on transparencies.

Your printout is faint or has gaps in the image.

- The print head nozzles may need cleaning; see page 37 for instructions.
- The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 39.
- Make sure the Media Type setting matches the paper you loaded. See page 33 for guidelines.
- Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, reload a new stack of paper with the printable side up; it is usually whiter or shinier than the other side.
You see wrong or missing colors.

- If you’re printing color images, make sure both your application and printer software are set for color printing.
- The print head nozzles may need cleaning; see page 37.
- The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 39.
- Try turning off PhotoEnhance™. Also check if you’re using a special effect that alters image colors, like Sepia.
- Try using Automatic mode. See page 21 (Windows) or page 25 (Macintosh OS X) for instructions.
- The color profiles built into your printer software automatically reference your monitor profile. Make sure that your monitor is calibrated correctly.
- Try changing the Gamma setting on the Advanced dialog box (Windows) or the Color Management dialog box (OS X).
- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system—such as ICM (Windows) or ColorSync (Macintosh)—to get as close as possible. See page 27 or page 31 for details.

Your printout is grainy.

- Try using a higher quality paper.
- Select a higher Print Quality (resolution) setting. See page 27 or page 31 for instructions.
- You may need to increase the image resolution or print it in a smaller size; see the instructions for your software documentation.
- Run the Print Head Alignment utility. See page 43 for instructions.

Problems with Paper Feeding

Too many copies are printing.
Check the Copies setting in both your printer software and application.

Paper doesn’t eject fully or is wrinkled.

- If the paper doesn’t eject fully, you may have set the wrong paper size. Press the □ maintenance button to eject the paper, then select the correct paper size.
- If it’s wrinkled when it ejects, the paper may be damp or too thin. Reload new paper.
Paper doesn’t feed correctly or jams in the printer.

- If paper doesn’t feed, remove it from the sheet feeder, reload it against the right edge, then slide the left edge guide against the paper.

- If multiple pages feed at once, remove the stack from the sheet feeder, fan the edges to separate the sheets, and carefully reload it.

- If paper jams, press the \( \text{\textbullet} \) maintenance button for several seconds to clear the jam. If that doesn’t work, turn off the printer and gently pull the paper forward (toward the output tray) to pull it out. Reload the paper and press the \( \text{\textbullet} \) maintenance button.

- If you try to print while the \( \text{\textbullet} \) maintenance light is on, your paper won’t feed properly. Press the \( \text{\textbullet} \) maintenance button to turn off the light before you print.

If your paper loads incorrectly or jams frequently:

- Use new, smooth, high-quality paper, loaded printable side up.

- Don’t load paper above the arrow mark on the left edge guide.

- Place the paper against the right edge and slide the left edge guide against it, but not too tightly.

Roll paper doesn’t feed correctly.

- To load paper correctly, gently hold the paper in place with your hand while you press the \( \text{\textbullet} \) button. Don’t force the paper to feed into the printer. Allow it to feed automatically.

- Use a triangle or other tool to make sure the end of the roll is cut perpendicular to the edges. If the end is cut on a diagonal, the paper may not feed smoothly.

- If you see a paper jam error message, press the \( \text{\textbullet} \) roll paper button for at least three seconds to clear the error.

- If the \( \text{\textbullet} \) maintenance light is on, press the \( \text{\textbullet} \) maintenance button and wait for the light to go off. Then press the \( \text{\textbullet} \) roll paper button to resume printing.

- Always select Roll Paper as the Paper Source setting. If Sheet Feeder (or Auto Sheet Feeder) is selected, paper will feed unnecessarily after each print job. In addition, a great deal of paper may feed unnecessarily when you turn your printer off and then on again.
If extra paper feeds after a print job or after you turn on the printer, press the \( \Rightarrow \) roll paper button for three seconds to rewind the paper. (You may need to repeat this step to rewind the paper completely.) Then press the \( \Rightarrow \) maintenance button to turn off the \( \Rightarrow \) maintenance light. Finally, reload the paper and press the \( \Rightarrow \) roll paper button again to resume printing.

If paper is curled, roll the paper inside the uncurling sheet in the direction opposite to the paper’s curl. You don’t need to uncurl the entire roll—only about 9 inches. See page 15 for details.

**Solving Miscellaneous Printout Problems**

The image is inverted, as if viewed in a mirror.

Turn off Flip Horizontal in the Advanced dialog box or the Mirror setting in your application. (If you’re printing on Epson Iron-On Transfer Paper, the image should be inverted.)

The printer prints blank pages.

Make sure your printer is selected in Windows, or as the active printer in the Printer Setup Utility or Print Center.

The print head nozzles may need cleaning. See page 37.

**The margins are incorrect.**

Make sure the paper settings in your printer software are correct for your paper size. See page 20 (Windows) or page 25 (Macintosh OS X) for instructions.

See your software documentation for instructions on choosing the correct margins for your paper size. The margins must be within the printable area of the page. See “Printer Specifications” in your on-screen Reference Guide.

Image size or position is incorrect.

Make sure paper and layout options are set correctly.

You see incorrect characters.

Make sure the interface cable is securely connected and meets the system requirements on page 63 or page 63. Then try printing again.

Make sure your printer is selected in Windows, or as the active printer in the Macintosh Printer Setup Utility or Print Center.

If you’re using a switch box or USB hub with your printer, connect the printer directly to your computer.
Uninstalling and Reinstalling the Windows Printer Software

If you are using Windows, you may need to uninstall and then reinstall your printer software. For example, this might be necessary when you upgrade your operating system. You don’t need to uninstall your photo software or on-screen Reference Guide, and you won’t see the license agreement when you reinstall your software.

**Note:** You don’t need to uninstall your printer driver for OS X; you can reinstall the printer driver over the old driver.

1. Open the Windows Control Panel and select *Add or Remove Programs* (or *Add/Remove Programs*).
2. Select *EPSON Printer Software* in the program list, and click the *Change/Remove* button.
3. In the next window, make sure the Epson Stylus Photo 1280 printer is selected and click *OK*. Then follow the on-screen instructions.
4. Restart your computer when you’re done. Then follow the instructions on the *Start Here* sheet to reinstall your software.
Where To Get Help

If you need help with your printer, see the contact information below. If you need help with the software that came with your printer, see the information on page 61.

Epson provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed in the following table:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach Epson Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your SoundAdvice™ Express Code is 68000. Use this code to quickly select the Epson Stylus Photo 1280 in Epson SoundAdvice.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial:

- U.S.: (562) 276-7296, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply. Before you call, please have the following information ready:

- Product name (Epson Stylus Photo 1280)
- Product serial number (located on the back of the printer)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration and operating system version
- Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller referral.
Software Technical Support

If you need help with the software that came with your printer, please contact the software manufacturer, as listed below.

<table>
<thead>
<tr>
<th>Software</th>
<th>Web site</th>
<th>E-mail</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Photoshop Elements</td>
<td><a href="http://www.adobe.com/support/main.html">www.adobe.com/support/main.html</a></td>
<td><a href="mailto:techdocs@adobe.com">techdocs@adobe.com</a></td>
<td>(206) 675-6126 6:00 A.M. to 5:00 P.M. Pacific Time, Monday through Friday (pay support)</td>
</tr>
<tr>
<td>GretagMacbeth Eye-One Share</td>
<td>—</td>
<td>—</td>
<td>(800) 622-2384 8:00 A.M. to 5:00 P.M. Eastern time, Monday through Friday</td>
</tr>
</tbody>
</table>
Notices

This chapter includes system requirements, safety instructions, legal notices, and warranty information.

Windows System Requirements

To use your printer and its software, your system should have:

- A Microsoft Windows compatible PC with a Pentium® or better processor, 200 MHz or faster, recommended
- A computer running Windows XP Home or Pro Edition with Service Pack 1 or Windows 2000 with Service Pack 4
- Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long
  
  **Caution:** Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.

- 64MB of RAM (128MB or more recommended)
- 150MB of free hard disk space (200MB or more recommended)
- VGA or better display adapter and monitor
- CD-ROM or DVD drive for installing the printer software

Macintosh System Requirements

To use your printer and its software, your system should have:

- An Apple® iMac™ series or Power Macintosh® G3, G4, or G5, PowerBook®, iBook®, or eMac™
- A Macintosh running OS X 10.2.8 to 10.4.x, with a built-in USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.
  
  **Caution:** Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.

- 128MB of available RAM; more recommended
- 150MB of free hard disk space (200MB recommended)
- VGA display or better
- CD-ROM or DVD drive for installing the printer software
Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.
■ Use only the type of power source indicated on the printer’s label.
■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
■ Place the printer near a wall outlet where the plug can be easily unplugged.
  Placez l'imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the printer for sufficient ventilation.
■ Do not place the printer near a radiator or heating vent or in direct sunlight.
■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.
■ Always turn the printer off using the \( \text{Power} \) button. The \( \text{Power} \) light flashes briefly and then goes off. Don’t switch off the power strip or unplug the printer until the \( \text{Power} \) light is off.
■ Do not block or cover the openings in the printer’s case or insert objects through the slots.
■ Except as specifically explained in this manual, do not attempt to service the printer yourself.
■ Unplug the printer and refer servicing to qualified service personnel under the following conditions:
  If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
■ The cords included with this product contain chemicals, including lead, known to the state of California to cause birth defects and other reproductive harm. Wash hands after handling.
Ink Cartridge Safety Instructions

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not put your hand inside the printer or touch the cartridge during printing.
- Do not move the print head by hand. You may damage the printer.
- Install the ink cartridge immediately after you remove it from its foil package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of first installing them.
- Store ink cartridges in a cool, dark place.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not shake an ink cartridge; this can cause leakage.
- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
- Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains in the proper position.

ENERGY STAR Compliance

As an ENERGY STAR® Partner, Epson has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name Epson
Type of Product: Ink Jet Printer
Model: Epson Stylus Photo 1280: P158A
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and used in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for the Epson printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson Connection™ at (562) 276-7296 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipment to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. This warranty is not transferable and will not apply to products purchased from an end user. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ● P.O. Box 93012 ● Long Beach, CA 90809-3012
Index

A

Accessories, 40, 60
Adobe Photoshop Elements, 8, 61
Advanced print settings
  Macintosh, 31 to 32
  Windows, 27 to 30
Aligning print head, 43 to 44
Automatic mode, 21, 24

B

Banding, 54
Basic printing
  Macintosh OS X, 23 to 26
  Windows, 20 to 22
Blank pages, 58
Blurry images, 55
Borderless printing, 23, 34 to 36
Bright White paper, 33
Buttons, printer, 48 to 50

C

Cable, printer, 63
Cancelling printing, 22, 26
Centering text or image, 29
Characters, incorrect, 58
Checking printer, 51
Cleaning
  print head, 37 to 38
  printer, 45
  sheets, 45
Color Management settings
  Mac OS X, 25, 32
  Windows, 28
Color problems, 56
ColorLife Photo Paper, 33
ColorSync, 25, 31
Control panel, 48 to 50
Controlling printing, 22, 26
Copies setting, 56
Customizing print settings
  Macintosh, 31 to 32
  Windows, 27 to 30

D

Declaration of Conformity, 67
Default settings, Windows, 22
Documentation, 8 to 10
Double-Sided Matte Paper, 33
Double-sided printing, 30

E

Economy setting, 27, 31
Electronic manual, 9 to 10
Elements, Photoshop, 8, 61
Energy Star compliance, 65
Envelopes
  loading, 13
  Media Type setting, 33
Epson
accessories, 40, 60
help, 60
papers, 33
PhotoCenter, 7
SoundAdvice, 60
Store, 40, 60
support site, 47
warranty, 68 to 69
Error lights, 48 to 50
Eye-One Share, 8, 61

F
Faint images, 55
Flip Horizontal setting, 58

G
Gamma setting, 25, 28
Glossy media, 33
Grainy prints, 56
Greeting cards, 33
GretagMacbeth Eye-One Share, 8, 61

H
Head Cleaning utility, 37 to 38
Heavyweight matte paper, 33
Help, Epson, 60
High Speed setting, 54
Holding a print job, 22, 26

I
ICC profiles, 7
ICM setting, 27
Image, resizing, 30
Incorrect
characters, 58
colors, 56
margins, 58
Ink cartridges
ordering, 40
replacing, 39 to 42
safety instructions, 65
storing, 65
Ink jet paper, 33
Ink jet transparencies, 33
Ink level, 22, 39, 41, 49
Ink setting, 21, 25
Installation problems, 52 to 53
Inverted image, 58
Iron-On Transfer paper, 33, 58

J
Jams, paper, 17, 50, 57

L
Landscape orientation, 23, 29
Layout problems, 58
Layout settings, 25, 30
Lever, thickness, 54, 55
Lights, 48 to 50
Loading paper, 11 to 17

72 Index
M
Macintosh
advanced printing, 31 to 32
basic printing, 23 to 26
cable, 63
cancelling printing, 26
customizing print settings, 31 to 32
layout settings, 25
Media Type setting, 25, 33
Print Center, 23
printer status, 26
prioritizing print jobs, 26
setting resolution, 32
system requirements, 63
USB cable, 63
Maintaining printer, 37 to 45
Marginless printing, 23, 34 to 36
Margins, incorrect, 58
Matte papers, 33
Media Type setting, 21, 24, 25, 33
MicroWeave setting, 54
Mirror images, 58
Monitoring ink level, 22, 39, 41, 49
Moving printer, 46

N
Network printing, 53
Noise, printer, 53
Nozzle check pattern, 38 to 39, 51

O
Orientation setting, 23, 29

P
Page Setup, Macintosh, 23
Paper
Epson, 33
feeding problems, 17, 56 to 58
jams, clearing, 17, 50, 57
loading, 11 to 16
orientation, 23, 29
Source setting, 29
thickness lever, 54, 55
Paper Size setting, 23, 29
Pausing printing, 22, 26
Photo paper, 33
Photo Quality Glossy paper, 33
Photo Quality Ink Jet paper, 33
Photo RPM, 28, 32
Photo Stickers, 33
PhotoCenter, 7
Photoshop Elements, 8, 61
Portrait orientation, 23, 29
Poster, printing, 30
Power light, 48 to 50
Premium Bright White paper, 33
Premium Luster Photo paper, 33
Print Center, 23
Print dialog box, 20
Print head
aligning, 43 to 44
cleaning, 37 to 38
Print quality problems, 54 to 56
Printable area, increasing, 29
Printer
cable, 63
check, 51
cleaning, 45
control panel, 48 to 50
maintaining, 37 to 45
noise, 53
parts, 48
problems, 49 to 51, 53 to 54
status, 22, 26
transporting, 46
Printing
advanced, 27 to 32  
basic, 20 to 26  
borderless, 23, 34 to 36  
controlling, 22, 26  
customizing, 27 to 32  
double-sided, 30  
ingoing printable area, 29  
on roll paper, 23, 29  
poster, 30  
prioritizing print jobs, 26  
rough drafts, 27, 31  
setting highest resolution, 28, 32  
slow, 53 to 54  

Problems
installing software, 52 to 53  
miscellaneous, 58  
paper feeding, 17, 56 to 58  
print quality, 54 to 56  
printing, 53 to 54  

Profiles, color, 7, 28  

Progress Meter, 22  

S  
Safety instructions, 64 to 65  
Saving settings, 28 to 29  
Scrapbook paper, 33  
Self adhesive sheets, 33  
Semigloss Scrapbook Photo paper, 33  
Sheet feeder
loading envelopes, 13  
loading paper, 11 to 12  
problems, 56 to 57  
Slow printing, 53  
Smears, 55  
Software
problems, solving, 52 to 53  
reinstalling, 59  
uninstalling, 59  
updates, 47  
Software support, 61  
SoundAdvice, 60  
Source, paper, 29  
sRGB setting, 27  
Stickers, 33  
Support, 60 to 61  
System requirements, 63  

T  
Technical support, 60 to 61  
Thickness lever, 54, 55  
Transfer paper, Iron-On, 33, 58  
Transparencies, 33  
Transporting printer, 46  
Troubleshooting, 47 to 58  

R  
Reference Guide, 9 to 10  
Reinstalling software, 59  
Resizing image, 30  
Resolution, setting highest, 28, 32  
Roll paper
  clearing jams, 17, 50  
  feeding problems, 17, 57 to 58  
  loading, 14 to 17  
  printing on, 23, 29  
  removing, 17 to 18  
  storing, 17 to 18  
Rotating image, 29
U
Uninstalling software, 59
Updates, software, 47
USB cable, 63
Utilities
   Head Cleaning, 37 to 38
   Print Head Alignment, 43 to 44

W
Warranty, 68 to 69
Watermark, adding, 30
Windows
   advanced printing, 27 to 30
   basic printing, 20 to 22
   cancelling printing, 22
   customizing print settings, 27 to 30
   default settings, 22
   layout settings, 30
   Media Type setting, 21, 33
   printer status, 22
   saving your settings, 28 to 29
   setting highest resolution, 28
   system requirements, 63
   USB cable, 63
World Wide Web, 60
Epson Ink Jet Papers and Ink Cartridges

Use Epson® paper and inks to get the same photo-quality results that have earned Epson printers all their awards! Epson papers are specially coated to work with genuine Epson inks. You’ll notice that when prints come out of your printer, the images are crisp and smooth. There are details about just a few of Epson’s papers and your printer’s ink cartridges:

**Borderless Premium Glossy Photo Paper**
Water-resistant, photographic-weight paper featuring Epson’s BorderFree® technology, this paper lets you print frame-ready photos in a matter of minutes.

**Semigloss Scrapbook Photo Paper**
Ideal for printing photos with a satin finish. Acid-free and buffered, these pages will last up to 60 years when stored in an album.

**Matte Paper Heavyweight**
Professional-looking, flat matte finish for printing photos and graphics on a non-glossy surface. Perfect for digital fine art work.

For best results, always use genuine Epson ink cartridges:

**T007201 (Black)**
**T009201 (Color)**

Epson Ink Cartridges

For more information on other Epson products and fun project ideas, look for the Epson Print Lab™ Series at www.printlabseries.com.

See the inside back cover for a partial list of Epson papers and ordering information.

---

Where To Purchase Epson Ink and Paper

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call 800-463-7766 for dealer referral.

### Epson Ink Cartridges

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041054</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper/Photo Paper</td>
<td>4 x 6 inches, non-perforated, Borderless</td>
<td>S041809</td>
</tr>
<tr>
<td>Epson ColorLife® Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041500</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches, Borderless</td>
<td>S041467</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches, Borderless</td>
<td>S041468</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041263</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041431</td>
</tr>
<tr>
<td></td>
<td>5 x 7 inches, Borderless</td>
<td>S041464</td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches, Borderless</td>
<td>S041465</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches</td>
<td>S041466</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041289</td>
</tr>
<tr>
<td></td>
<td>4 inches x 26 feet (Roll)</td>
<td>S041302</td>
</tr>
<tr>
<td></td>
<td>8.3 inches x 32.8 feet (Roll)</td>
<td>S041376</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041426</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041327</td>
</tr>
<tr>
<td></td>
<td>4 inches x 26 feet (Roll)</td>
<td>S041329</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041420</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041407</td>
</tr>
<tr>
<td></td>
<td>4 inches x 26 feet (Roll)</td>
<td>S041408</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Greeting Cards</td>
<td>Letter (8.5 x 11 inches), perforated edges</td>
<td>S041606</td>
</tr>
<tr>
<td>Epson Photo Stickers®</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041144</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
</tr>
</tbody>
</table>
Epson Ink Jet Papers and Ink Cartridges

Use Epson® paper and inks to get the same photo-quality results that have earned Epson printers all their awards! Epson papers are specially coated to work with genuine Epson inks. You’ll notice that when prints come out of your printer, the images are crisp and smooth. Here are details about just a few of Epson’s papers and your printer’s ink cartridges:

**Borderless Premium Glossy Photo Paper**
Water-resistant, photographic-weight paper featuring Epson’s BorderFree® technology, this paper lets you print frame-ready photos in a matter of minutes.

**Semigloss Scrapbook Photo Paper**
Ideal for printing photos with a satin finish. Acid-free and buffered, these pages will last up to 60 years when stored in an album.

**Matte Paper Heavyweight**
Professional-looking, flat matte finish for printing photos and graphics on a non-glossy surface. Perfect for digital fine art work.

### Epson Ink Cartridges

For best results, always use genuine Epson ink cartridges.

**T007201 (Black) / T009201 (Color)**

For more information on other Epson products and fun project ideas, look for the Epson Print Lab™ Series at www.printlabseries.com.

#### Table of Papers and Ink Cartridges

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Cards</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041054</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper/Photo Paper</td>
<td>4 x 6 inches, non-perforated, Borderless</td>
<td>S041809</td>
</tr>
<tr>
<td>Epson ColorLife® Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041500</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041968</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041286</td>
</tr>
<tr>
<td>Epson Premium Semi Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041301</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041327</td>
</tr>
<tr>
<td>Epson Premium Semi Glossy Scrapbook Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041407</td>
</tr>
<tr>
<td>Epson Inkjet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041964</td>
</tr>
<tr>
<td>Epson Photo Quality Self Adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
</tr>
</tbody>
</table>

Where To Purchase Epson Ink and Paper

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call 800-463-7766 for dealer referral.

**Epson Ink Cartridges**

<table>
<thead>
<tr>
<th>T007201 (Black) / T009201 (Color)</th>
<th>T007201 (Black) / T009201 (Color)</th>
</tr>
</thead>
</table>

See the inside back cover for a partial list of Epson papers and ordering information.